
NEW FEATURES IN gINT VERSION 8

gINT Version 8 has over 100 new features in the following areas:

Data Design

Feature Levels* Description

Caption property value
changes object selector
display

All If at least one record has a value in the Caption property,
the object selector list displays a column for Caption, in
addition to Name, Date, and Description.

Cell Color option All You can set the background color for non-required, non-
read-only fields in Input and Data Design.

Filling in empty parent
records

All In tables that have two keys for their Key Set property (for
example, PointID,Depth), two additional properties appear
on the Table properties dialog box.
Create missing records on Import
Create missing records in Input (1-1 only)

Group Name drop-down
option

All Displays a list of all groups currently defined in the
database. To define a new group for the current table, type
the name in the New Group field.

"Group Separator" property
of component description
library tables

All Groups the preceeding components, up to the last group
separator, into one group with a final separator.

Library table key field data
types

All Library table key fields can now have any of the following
data types:

Currency
Date/Time
Double
Integer
Long
Single
Text (default)

Previously only Text was supported.

Lookup list field association All Lookups may now be associated with any of the following
field types:

Currency
Double
Integer
Long
Single
Text

Previously lookups could only be assigned to Text fields.

One-to-one split screen child All One-to-one child tables may now be selected as a split
screen child of its parent. Previously, only one-to-many
child tables could be selected.

Asia-Pacific Distributor • Datgel • Suite 8, 89-97 Jones Street • Ultimo • NSW • 2007 • Australia

Phone: +61 2 9281 6118 • Fax: +61 2 9281 6137 www.datgel.com.au• Email: info@datgel.com.au • Web:



New Features in gINT Version 8

2

Feature Levels* Description

Position graphic lookup type All The new Graphic lookup type called Position allows you to
set posting positions for data on graph and site map reports.

Rules for Date/Time fields All The Field Rulesdialog box for Date/Time type fields
contains three options: Date and Time, Date Only, and Time
Only.

Set Empty Sources to
<<Omit>> button on the
Correspondence Files tab

All If clicked, all Default Source Table values that are not
assigned are set to <<Omit>>. Only enabled in grid mode.

Tables > Point Sort Field
menu option

All Enabled (in Input and Output) when the Point table is the
currently selected table. It inserts or removes a system field
named GintPointSort which will sort the PointIDs by the
contents of this field.

User-defined project-level
tables

All
within a project database.

Functions

Feature Levels* Description

DateAdd All Allows you to add an interval of time to a specified date and
returns the new date.

FormatDualDates All Formats a date range and eliminates duplicated parts of the
resultant range.

GraphValue Pro The first argument of the GraphValue function can now
support return of values from multiple plot sets on a graph.

Special use of SqlRange Pro SqlRange now supports extraction of data from specific plot
sets on a graph.

UnionKeys All Used in correspondence files when you are importing from a
non-gINT source (csv, xls, mdb) and the table group has
multiple source tables.

General

Feature Levels* Description

Access to manuals All The Manuals button on the opening screen brings up the list
of PDF documents in the gINT docs folder.

Context menu in text boxes
for expressions

All In text boxes that allow you to write expressions, when you
right-click a context menu is displayed.

User-defined project-level tables can be created from Input
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Feature Levels* Description

Copy & paste grid cells All In grid screens you can copy and paste cells between gINT
and Excel®, or Word (as a table).

Create new project at
opening screen

All A project may be started in the opening screen.

European numeric formatting
with Format functions"
property

All Changes the formatting of numeric data using the Format and
FormatSci functions to use the European decimal (",") and
thousands separator (".").

File > Library List menu
option

All Returns a list of all gINT libraries contained in folders that
had been accessed previously in gINT by the workstation.

Help > Manuals menu option All Brings up the list of PDF documents in the gINT docs folder.

Multiple WAN license servers A ll Multiple WAN servers can be specified and the program will
search each for an available license.

New shortcuts All CTRL+F5 = Zoom Extent (giDraw)
SHIFT+F5 = Zoom Previous (giDraw)
ALT+F5 = Zoom Paper Outline (giDraw)
F8 = Application properties dialog
Ctrl+F8 = Application list dialog

Program prompts to save
data

All In the prompt to save message box, if you click the Don't
show again option, the program no longer prompts, but saves
automatically.

Web interface All Any file or Web page that can be displayed in a Web browser
can be seen in a window on the opening screen.

gIDraw Application

Feature Levels* Description

Copy/cut selected entities to
buffer using the Select
Entities command

All Selected entities can be copied or cut to the buffer using the
Select Entities command in gIDraw apps.

Floating toolbox All The gIDraw toolbox can now be floating and can be dragged
to any of the five positions (top, left, bottom, right, floating)
with the mouse.

Polyline Fill & Line Type
Display menu option

All If checked, polyline entities will display their actual line
types and main fill while in design view.

Print Order recognized at
design time.

All The Print Order property of entities is now recognized at
design-time.

Scroll bars added to gIDraw
applications

All The 2% and 20% scroll buttons in gIDraw have been replaced
with scroll bars.
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gINT Rules

Feature Levels* Description

Before Command System oddt Logs+,
Pro

Allows you to specify a gINT Rule that is to be run before any
command is executed.

CancelChanges property Logs+,
Pro

If set to True the current screen's data reverts to the last
saved configuration.

CancelCommand property Logs+,
Pro

Forces the current command to be cancelled.

CurrentApplication property
of the gINTRules object

Logs+,
Pro

This returns the current application when running code in the
Before Command system oddt.

CurrentCommand property Logs+,
Pro

Returns the command identifier for the current command.

ExecuteProgram method of
the gINTRules object

Logs+,
Pro

Launches a program and optionally passes a file name to
open by the program.

GintConfig.HideApplication
property

Logs+,
Pro

Hides the specified gINT application.

GintConfig.HideGroup
property

Logs+,
Pro

Hides the specified gINT application group.

GintConfig.UserName
property

Logs+,
Pro

Returns the name of the user currently logged onto the
workstation.

GridData.FirstVisibleFieldPs
property

Logs+,
Pro

Returns the field position of the first field that is visible in
the current grid.

Help button added to Code
Tab

Logs+,
Pro

A Help button was added to the Code tab of the gINT Rules
dialog box.

HideTable method of the
gINTRules.GridData object

Logs+,
Pro

Hides or unhides a specified table in the current project.

LibraryFile property of the
gINTRules.GintConfig object

Logs+,
Pro

Returns the full path and file name of the current library.

On Library Open System oddt Logs+,
Pro

Allows you to specify a gINT Rule that is to be run on opening
a library file.

On Open Project in Input
System oddt

Logs+,
Pro

Allows writing code that executes on opening a project in
Input.

PointInsideArea property Logs+,
Pro

Returns True or False as to whether a specified X,Y
coordinate pair fall inside the area defined by the
PointInsideAreaInit method.

PointInsideAreaInit Method Logs+,
Pro

Initializes an area that will be used by the PointInsideArea
property to determine if a specified X,Y point is inside the
area.
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Feature Levels* Description

Procedures Button Logs+,
Pro

Generates a list of all the procedures in the currently
selected module.

SurfaceZValueFromXY
property

Logs+,
Pro

Given the name of a project surface and an X,Y coordinate,
the Z value on the surface is returned.

UUID property Logs+,
Pro

Returns a Universally Unique Identifier which changes every
time the property is called.

Import/Export

Feature Levels* Description

Export in Geopak® GTD
format

Logs+,
Pro

More complete format than the CSV format for Geopak
export.

LogPlot Tadpole support All The LogPlot® 2005 "Tadpole" da ta type is now recognized by
gINT and associated data can be imported.

Support for tables with a
record count of more than
65k

All The Export to Excel option in Input now supports tables with
more than 64K records.

Input

Feature Levels* Description

Calculating the Friction angle
and cohesion in Direct Shear
tables

All The automatic calculation of calculated friction angle and
cohesion in the built-in Direct Shear tables in gINT lab testing
recalculates the friction angle if the cohesion calculates to
less than 0.

Copy and pasting cells
between projects in Input

All Cut or copied rows in INPUT can be pasted into another
project and then, on returning to the original project, can be
pasted again, if desired.

Input table remembered All On leaving Input and returning, control returns to the table
that was current when the application was exited.

New > Tables menu option in
INPUT

All The Tables > New menu option in the INPUT application
group allows you to add new tables without moving to the
Project Database application.

Replicate All Child Data
option

All Performs the replication of all data associated with the
currently select PointID. If unchecked, the command only
replicates direct dependents of the POINT table. This was
the previous behavior.
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Feature Levels* Description

Resizing the child grid in a
split screen

All In a split screen with a child screen, the child grid can be
vertically resized to take up more (or less) of the total
screen.

Tables > Last Update Field
menu option in Input

All Tables > Last Update Field menu option allows you to add or
remove the Last Update system field from the current table
without having to move to the Data Design application.

Output

Feature Levels* Description

Data Statistics option in Text
Tables

All Gives the median for each column that has more than 1
numeric value.

DateTime graph support for
logarithmic scales

Pro DateTime graphs now support a logarithmic scale.

File > Queries menu option in
Output

All Used to run a SQL expression against the currently selected
project or projects.

Initial Baseline Distance field
in Fences

Pro Offsets the fence baseline distances.

Multi Project option for all
Output formats

All Multiple projects may be selected for output at one time.

Site Map Only checkbox in
Site Maps

All Forces the output of only the site map. PointID information is
not plotted.

Report Design

Feature Levels* Description

Don't Show Page Properties
on Screen option for Graphs,
Histograms and Site Maps

Pro Suppresses the display of the data expressions specified in
the report properties.

Expand Frame to Fit Scale
option for Fences

Pro Increases the frame width and/or height if scales are
specified that require frame expansion. For DXF and gINT
drawing file export formats.

Force Lines Through Origin
option on Data
Representation tab of Graphs

Pro Affects only the Best Fit options. Gives the options of Never,
Only if intercept is negative, and Always.

Foreign PointID Expression
property on the Configuration

All Overrides the PointID that will be used in extracting data for
the entity.
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Feature Levels* Description

tab of Log reports

GraphicInput system data
item for reports

All Returns -1 (True) if the report is displayed in the Graphic
Input View, otherwise returns 0 (False).

Grid Minor tab in report
properties

Pro Allows setting of grid lines or ticks between the major grid
lines in Fence, Graph, and Site Map reports.

ID Text Position Expression
on Data Representation tab
for Graphs and Site Maps

Pro Allows you to use an expression to specify the data position.

Layer properties Pro Properties for the placing of specific elements on named
layers in Graph and Site Map reports.

Limits of Curves option from
Equations graph report
property

Pro The limits of the curves generated by the Curves from
Equations property of the Data Representation tab on the
Graph report properties dialog box can now be set.
Previously they extended across the full graph range.

Number of Additional Pages
Expression in Logs report
properties

All Forces additional pages to print after the log data pages.

Overflow Option list on Data
tab for Histograms

Pro Specifies what to do with data values that are outside the
specified data minimum and maximum limits.

Display Report Properties on
Graphs, Histograms and Site
Maps

Pro Double-clicking in the data frame displays the properties
dialog box.

Background Fill tab on Bar
Chart entities for Log and
Fence reports

All Allows you to set background fills and colors that can be hard
coded or made variable with expressions. You can also apply
an output condition that specifies when the fill is output.

Boundary Depth Expression
option on Plot vs Depth
entities

All Expanded capabilities that gives control over plotted values
at specified boundaries.

Column Header Height
option on Log report Column
and Lines tab required value
message

All When creating on column entity, if the report Column Header
Height is not defined, a dialog box is displayed prompting
you for a Column Header Height value. If a value is not
supplied, the column entity drawing command is canceled.

Draw > Shapes > True
Rectangle menu option

All This new entity defines a rectangle with either fixed or
variable width and height properties.

Force PointID to Center
option of Site Map entities in
log reports

All Forces the current PointID to the center of the site map
rectangle.

Site Maps > Zones menu
options

All Allows definitions of zones (closed areas) on a site map. In
Output applications you can then filter on specific zones.

Show with No Site Map
option on Configuration tab of
Site Map entity in Log reports

All If selected, the site map entity is output odd if no site map
exists.
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Feature Levels* Description

Suppress Horizontal Lines
option on the Range Lines tab
of Text vs. Depth entities

All Suppresses the printing of the horizontal lines between
ranges. Only the arrows and vertical lines will print.

Scripts

Feature Levels* Description

Execute Program menu
option

All The Execute Program option on the Scripts menu allows you
to launch another program or view a file in another program.

Exporting to a RockWorks file
using a script

All The File > Import/Export > Export to RockWorks File
command in Input can be executed using a script.

Scripts feature available in
multiple applications

All Scripts can be run from the main menu, Output, Input and
Utilities application groups. Previously they could only be
executed in Output.

Site Map

Feature Levels* Description

Convert Closed Polyline to
Zone menu option

All Converts a selected closed polyline to a zone entity.

Go to Zone menu option for
Site Maps

All Prompts the user to select a zone using a picklist of all the
zones currently defined in the Site Map.

New Zone menu option in Site
Maps

All Inserts a new zone entity on the site map.

Project Data in Site Map All Now only shows the tables in the project where data exists
for the selected borehole. Previously, all tables were shown
whether there were data or not.

User System Data

Feature Levels* Description

Histogram_Median Pro Returns the median value of the data reported by the
histogram report.

LogContTextTopDepth All Is only used by the Text vs Depth and Text vs Depth Column
entities in log reports. Returns the top depth of the layer
that was continued.
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Feature Levels* Description

Omit Logs+,
Pro

When used in the Separator field of a component description
table in Library Data application of DATA DESIGN omits any
separator.

OutputKeys Pro Returns the key list of all records that are output in the form
<keys1>,<keys2>, and so on.

OutputZoneFilter All Returns the zone filter specified at output time in a comma
delimited list.

Random All Returns a random number between 0 and 1.

RecordNumber Pro Returns the record number of the current plot record in
Graph reports.

SymbolHeightGTWidth All Returns True if the bitmap symbol Height is greater than the
Width.

UserName All Returns the name of the user currently logged onto the
workstation.

Utilities & More

Feature Levels* Description

Hide associated applications All This property of the Secure Library command will hide all
locked applications in a locked library.

Print Object Lists export
functionality

All You can use the Print Object Lists application in Utilities to
export to any of the program's supported export graphic
formats.

Grid Spacing All Gives the spacing between grid lines in the East and North
directions.

Caption column displayed in
object selector drop-down

All If at least one symbol has a value in the Caption field, the
object selector list displays a column for "Caption", in
addition to "Name," "Date," and "Description."

*gINT Levels:

• All = gINT Logs, gINT Logs Plus and gINT Professional

• Logs+ = gINT Logs Plus

• Pro = gINT Professional
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